
 

 

 

 

 

 

 

 

 

 
K2's Using OneNote More And Email Less 

 

OneNote is a fantastic application included in your Microsoft 365 subscription.  Yet, it is 
underutilized and misunderstood most of the time.  If you genuinely want to change how you 
work, embrace OneNote.  Stop using Outlook as a filing cabinet for essential emails and move 
them to OneNote instead.  If you share a OneNote notebook with others, you can stop emailing 
altogether within your group and use OneNote as your collaboration and reference platform. 
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Introduction 
OneNote is a fantastic application included in your Microsoft 365 subscription.  Yet, it is 
underutilized and misunderstood most of the time.  If you genuinely want to change how you 
work, embrace OneNote.  Stop using Outlook as a filing cabinet for essential emails and move 
them to OneNote instead.  If you share a OneNote notebook with others, you can stop emailing 
altogether within your group and use OneNote as your collaboration and reference platform.  

Major Topics  
• Using OneNote as a powerful reference resource  
• Learn how to move your emails into OneNote  
• Share OneNote with a group of people and communicate within a notebook rather than 

email.   

Learning Objectives  
• List tasks for which you might choose to use OneNote  
• Identify ways to reduce email and use OneNote for yourself and your group or team  
• Cite examples of how you can use OneNote for storing and retrieving important reference 

information  
• Identify the process for acquiring OneNote  

What Is OneNote 
OneNote is your all-in-one digital notebook that can replace your paper notebook. It’s the perfect 
place to track necessary information, including notes, emails, documents, pictures, and links. 

With OneNote, you no longer need to rely on paper for notebooks, lists, or sticky notes. For 
example, you can use it before, during, and after meetings to ensure all the required information 
is in one place and easily shared with everyone who attended. 

OneNote can help you stay organized and increase efficiency by providing a centralized location 
for all your information. Plus, because it’s a digital notebook, you’ll never have to worry about 
losing important notes or papers again. 

OneNote is also an excellent tool for collaboration. You can share your notebooks with your team 
to reduce email traffic and make it easier to work together. For example, you can use OneNote 
to capture updates and references on a project and share them with others in your team. 

Whether taking notes for yourself or sharing them with others, OneNote is an essential part of 
Microsoft 365. It integrates seamlessly with Microsoft Outlook and Microsoft Teams, making it a 
versatile and robust solution for anyone looking to stay organized and productive. 
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OneNote Is Available On Many Devices 
OneNote is readily available to anyone, and you can also download it free of charge from 
Microsoft’s website.  

Use OneNote on the following devices: 

• On a PC or  Mac computer 

• On the web 

• On an iPhone or Android phone 

• On an iPad or Galaxy/Android device 

If you log into these devices with the same Microsoft account, you can access the same 
notebooks, no matter which device you choose. 

Two Desktop Versions Of OneNote 
At the time of this writing, two OneNote applications are available for a PC: 

• The OneNote app, which comes with Microsoft 365 and  
• OneNote for Windows, which comes with Windows. 

 

You may already have these applications on your PC, or you can download either one. These 
applications do look a little different from one another, but they perform all the same functions. 
For this instruction, we will use the OneNote app. 

Creating Your First Notebook 
There is no limit to how many notebooks you can create. When creating notebooks, save them 
consistently in the same location so it is easier for you to find them. You may want to create a 
Notebooks folder on your OneDrive.  

Once the OneNote app is open on your computer, go to File and choose New. Then navigate to 
the OneDrive or SharePoint location where you want to create the notebook. If you use Teams 
and plan on sharing this notebook, it is best to establish it in Teams. 

Opening OneNote From A Different Device/Computer 
Let’s say you use OneNote on your desktop computer at work. However, you may also want to 
access this same notebook on your laptop, phone, iPad, or another computer – perhaps one that 
doesn’t belong to you.  

1. Once you have the OneNote app open on your computer, go to File, choose Open, and 
navigate to the OneDrive or SharePoint location where you saved the notebook 

2. From the app on your iPad or phone, you go to the More Notebooks option to open any 
existing notebooks. 
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Opening OneNote From The Web Application 
Assuming you have Microsoft 365 and are actively using Microsoft OneDrive or Teams and 
SharePoint, you can access your notebook from any computer by going to the web and logging 
into your Microsoft account. 

1. Go to the login page for Microsoft at www.office.com. 

2. Log in to your Microsoft account using the appropriate email and password. Do not save 
this login information to a device that does not belong to you. 

3. Go to the waffle menu at the top left of the Microsoft window, and choose OneNote. 

4. Click My Notebooks to see all notebooks created using the current Microsoft login. 

5. To open one of the notebooks, click on the notebook name. 

Storing And Retrieving Information Easily 
OneNote is a potent tool for storing and retrieving information. Whether you’re taking notes in 
a meeting, gathering research for a project, or keeping track of your to-do list, OneNote makes it 
easy to capture and organize your thoughts. With features like notebooks, sections, pages, tags, 
links, website links, and searching, you can quickly find the information you need when you need 
it. This section explores how OneNote can help you store and retrieve data efficiently to stay 
organized and focused. 

Let’s look at how the notebook itself is structured. Each notebook has sections and pages to help 
categorize your information. 

Creating Notebooks, Sections, And Pages 
To achieve better organization, find the best way to store notes and related information with 
Microsoft OneNote.  

Fundamental to organizing within OneNote is this program’s system of: 

1. Notebooks,  
2. Notebooks have Sections and  
3. Sections have Pages. 
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1. Click on the Plus sign to add a section to the notebook. 
2. Alternatively, right-click on any Tab to add a new section 

 

Creating A Page In The OneNote App 
You can have as many pages as you need in any section of your Notebooks. Click Add a Page on 
the screen’s right to add a page. A page in OneNote is not the size of a piece of paper; there are 
no definitive limits. If you plan to print your OneNote notes,  use a Page template for that paper 
size. 
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Entering Information Into Your Pages 
Entering into a notebook page is different from typing into a Word document. There are no pre-
defined page dimensions. Your notebook page can be as wide and as long as you want it to be. If 
you wish to print information from your page eventually, you may want to type into a standard 
page width.  

Titles 
The title of your Page becomes the title on the right side. 

Typing Text 
If you press Enter, you can continue typing text like you would in Word or other Microsoft programs. 
Following is an example of a Container. 

  
If you click somewhere outside this area, you create a new Container. Each container can be sized 
or moved. Further, Containers can hold more than just text. Containers store anything you add 
to your notebook, such as:  
• Pictures,  
• Emails (from Outlook),  
• Word or Excel documents (or any other type of document)  
• Audio or video clips 
• Hand writings /drawings 

  
You can click on the Border of the Container and move or delete the container if necessary. 

More Notebooks 
Once you have notebooks created, if you go to another device and use OneNote, you will need 
to open up the notebooks you have created (on other devices). Use the More Notebooks option 
to open up these other notebooks. You may also need to do this if you’ve opened a notebook in 
Teams and now want to see that notebook in your OneNote App.  
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Add Emails To OneNote 
You can easily add an email from Outlook to OneNote. 
This action copies the email from Outlook; it does not 
move it. 

1. Click and Drag an Email from Outlook into a 
notebook Page. 

2. Insert as an attachment. 
3. Or choose to Save to OneDrive and link from 

OneDrive. 
 

 

Use Send to OneNote button in Outlook 
If you use Microsoft 365, another way to add an email to OneNote is to use the 
Send to OneNote button on the Home tab of the Ribbon in Outlook.  When you 
use this button, you send the selected Email Message to a page in a OneNote 
notebook.  

 

For this button to work, you must create at least one note in Microsoft OneNote. You also should 
have opened that notebook on your computer. 

1. Click on a Message in Outlook. The message could be in the inbox or any other folder. 
2. Click on the Send to OneNote button on the Home Ribbon. 
3. Choose the notebook and section from Recents, or scroll down 

to choose a different notebook. If you do not choose the Recent 
Section, when you select a notebook, click the arrow to choose 
the Section. 

4. Click the Save button. 
 

This email is still in Outlook, but now a copy is also in Microsoft OneNote. 
If you delete the email from Outlook, its copy remains in OneNote. 
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Documents 
You can add a Document to OneNote as a: 

• File Printout (Insert Toolbar) 
• File Attachment (Insert Toolbar or Drag & Drop) 
• Copy Link 

 

File Printout 
File Printout gives you the best of both worlds; you have an attachment and a printout of what 
the file looks like. After you create this File Printout, you could remove the attachment or the 
printout. To do so, click on hit and press Delete. 

This File Printout occupies your notebook and is not attached or linked to the original file. If you 
make changes in this object, it does not change the original file. This printout is a copy. 
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File Attachment 
File Attachment is just like an email attachment. It consumes space and appears 
as an attachment. To read the attachment, you will need to double-click on it.  
 
Document Link 
A Document Link takes up no space in your notebook and always links to the 
source of information. Links may originate from your computer, network, cloud drive, website, 
etc. 

Example Link: Top Ten Time-Saving Tips for Computers 

 

Do You Have Access To The Link When You Need It? 
When linking to a file in your notebook, ensure you have access to that location. For example, will you 
need access to that file if you are out of the office? If you do, link the file via a remote cloud site like 
OneDrive, SharePoint, or Dropbox. 

Links 
Use Links in OneNote to reference or relate one piece of information to another. For example, 
you can link a paragraph, a page, or an entire section. 

Paragraph Links 
Copy Links from One Paragraph to a Word or Phrase:  

 • On the same page,  

 • In a different section, 

 • In a different notebook 

Copying Links From The Paragraph 
Following are the steps to use if you wish to link a paragraph to another page in a notebook.  

1. Right Click on a Paragraph or a Page 
2. Choose Copy Link to Paragraph (or page) 
3. Go to where you want to view the Link 
4. Paste (Ctrl-V or Right click) 

 

You will then see an underlined word or phrase.  
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As shown below, you can also copy Links from one paragraph to another area on the same page. 

  

  

Link To Another Page In Your Notebook 
In this example, we begin on the page where we want the link to reside, and then we will find 
the linked page to link it. 
 

1. Click on the Insert Ribbon 
2. Choose the Link button from Insert Ribbon 
3. Choose the appropriate notebook and page with the information you want to link.  
4. The “linked” word or phrase will appear underlined in your notebook. If you click this 

word (or phrase), it will take you to that Page in the notebook. 
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Link To All The Pages In A Section 

 
  

1. Click on the first page in the 
section. 

2. Shift-Click on the last page in 
the section. 

3. Right-click in that selection, 
and choose Copy Link to Page. 

4. Go to the page where you 
want these links to appear and  
choose Paste. 

  
  

Link to A Page In Another Section 
This example will link to the To Do List page in the Templates section of the Classroom notebook. 

1. Click on the Insert Ribbon. 
2. Choose the Link button from the Insert tab of the Ribbon. 

a. Choose the appropriate notebook and page with the information you want to link to; 
for example, Go to notebook Classroom, choose the Templates section Templates, 
and choose the Page entitled To Do List. 

3. The word will appear underlined in your notebook. The underlining refers to the link. 
Clicking this word (or phrase) will take you to the Page in the linked notebook. 

To Do List 
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Go Back To Previous Page 
To return to the page you were just on, click the Back button in your Quick Access menu. The 
Quick Access Menu is at the top left side of your screen (above your Ribbon bar). 
 
The Back button is the first button on the Quick Access bar. 
  

 

  
You can customize the Quick Access bar.   
If your menu does not look like the one displayed above, click on the arrow on the right side to 
customize your Quick Access bar. 
 
If you cannot see your Quick Access bar at all, 

1. Right-click on your Toolbar and  
2. Choose Show Quick Access Toolbar. 

  

Edit Your Link 
You can edit a link once you have created it. For example, you may want to edit a link to rename 
it. 

1. Right-click on the linked item. 
2. Choose Edit Link. 
3. Change Text to Display to rename the link. 
4. Also, you may want to change what you linked. 

a. Change the notebook page you linked. 
b. Change the file you linked. 
c. Change the website you linked. 

 

Referencing Your Notes With Tags 
You can use Tags to help highlight your note, just like you would highlight paper-based notes. 
You will find Tags on the Home tab of the Ribbon. 



Page 13 of 26 
 

Copyright © 2023, K2 Enterprises, LLC.  
Reproduction or reuse for purposes other than a K2 Enterprises training event is prohibited. 

 

Types Of Tags 
• Tag Important Notes (CTRL - 2) or choose Tag from the 

menu. 
• Did you write something down and want to remember 

it as a Question? Use the Question Tag (Ctrl - 3). 
• Remember this for later (Ctrl - 4) 
• Create a To-Do box within your Notes (not linked to 

Tasks in Outlook) (Ctrl - 1) 
 
Create Custome Tags 
To create your custom Tags or change the ones in the Tags list: 

1. From the Tags drop-down,  
2. Go to the bottom of the list and  
3. Choose Customize Tags 

 
Turn a Tag Off the same way you turned the Tag on (with the 
menu or shortcut keys). For example, CTRL - 0 removes any tags 
you have highlighted. 

 
1OneNote for Windows 10 

 
 

In OneNote App, tags are on 
the Home Ribbon. 
 
Use the drop-down arrows 
to choose from the many 
tags available. 
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Search for Tags 
Retrieve anything fast in OneNote. With Tags, you have a new way to find information – find it 
based on the Tag you used! 

Searching For Tags In The OneNote App  

 

From the Home Ribbon, click Find Tags. 

The Tags Summary is shown on the right side of 
your screen when you click Find Tags. 

 

As the name suggests, you now have a summary of 
your tags. 

But how do you want to GROUP these tags? From 
the Group tags by box, choose from Tag Name, 
Section, Title, Date, and Note Text. 

Our example to the left summarizes data by Tag 
name. 

Also, when summarizing your Tags, you must decide 
how much of a summary you need. For example, 
from what sections of your notebooks are you 
summarizing this Tag Search? 

See all your choices below: 
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Searching Notes 
Find anything fast in OneNote with searching! Like searching for tags on your pages, you can find 
any text you enter. As you accumulate a lot of notes in your notebooks, searching text becomes 
very helpful. For example, when you know you wrote a note but can’t remember where you 
saved it, you can search for it. Search works in the notebooks on your computer, smartphone, 
and tablet. 

In the OneNote App, there are two Search boxes to choose from: 

1. The Search box at the top of your OneNote app window, which you can access with the 
Alt-Q keyboard shortcut. 

 
2. The Search box at the top right side of your page is accessible with a CTRL-E or CTRL-F 

Keyboard shortcut. 

 

CTRL-E will find words by looking through all your 
notebooks. 

CTRL-F  will find words by searching on the current page. 
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The Search Box Or CTRL-E 

When you use the search box at the top right corner 
of your screen, you can search for any word or phrase 
on the current page or all your notebooks. 

Notice from the example on the right that when we 
search for the word test, we find it in many different 
forms: 

• Recent pages visited 

• As part of a page title 

• As a word on a page. 

• As a word on a deleted page. Though this 
result does not appear in the screen capture, it 
is at the bottom of this search box. 

 

 

 

Search Box At Top Or ALT-Q 
The ALT-Q keyboard shortcut and this top 
search box in OneNote search for the 
words you enter throughout all of the 
Microsoft Office Apps. 

ALT-Q will find files in Word, PowerPoint, 
or Excel that contain the phrase you are 
searching. 

ALT-Q will find the same word or phrase 
in your notebooks. And you can also get 
help on whatever term you typed. 

ALT-Q may not be available on all 
versions of the OneNote app. 
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Recent Edits Or Recent Notes 
One helpful feature in OneNote App is the Recent Edits feature. Recent Edits us to find a list of 
the most recent changes to our notebooks. This feature can be handy when sharing notebooks 
with others or if we need to see what we added recently. 

 

1. Click on the History Ribbon in the 
OneNote App. 

2. Choose Recent Edits. 
3. Choose the time frame you want 

to look at. 

 

4. Review the list given on the right 
side of your screen. 

5. Note that you can change 
whether you want to search in  

a. this notebook or  
b. all notebooks or 
c. this section or 
d. this section group. 
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Extracting Information From Websites 
You can copy information from a website or show a website URL in your notebook page in a few 
ways. These include:  

 

• Copy the URL and paste it into your page. 
• Copy a paragraph from the website, and the URL of that website is included when you 

paste it. 
• Use a Web Clipper extension for your browser. 

Copy And Paste From A Website 
When you copy text or pictures or both from a website, you can paste them quickly into a 
OneNote page. When you do, OneNote will also give you the URL for that website so you have 
the reference. 

You can research a topic and copy information from websites while still keeping the website link 
available (or attached).  

1. Go to any website and select a paragraph or more. 
2. Choose Copy. 
3. Paste into your OneNote Page to show the paragraph with the link to where it came from. 
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Sharing Your Notes 
One of the key advantages of using OneNote is the ability to share your notes effortlessly with 
others. You have several options, such as sharing a single page or an entire notebook. Sharing a 
whole notebook is a breeze with the click of a button or by creating the notebook directly in 
Microsoft Teams. This streamlined sharing process ensures that your notes are easily accessible 
to anyone you share them with. 

Sharing a page of your notebook 
To share a single page of your notebook, you email it to the recipient(s). Note that you’ll share a 
final copy of the page rather than a live version. 

 

Email a Page from OneNote 
1. Click on the Share Button at the Top Right Corner 

of your screen. 
2. Choose Send Copy of Page. 
3. If you have others in your organization you are 

sharing your notebook with, you can send a LINK 
to the Page or choose Copy Link. 

 

 

 

Sharing A Notebook Link Via Email 
Rather than just sending a single notebook page, you can share a link to the entire notebook via 
email. To do this, click the Share button at the top right of your OneNote app screen. See the 
following figure for an example of the Send link dialogue box that appears when you choose. 
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Before you send a share like this, you must understand the settings available to you. When you 
click the first option in this dialogue box, Anyone with this link can edit. The following figure 
represents the settings available to you. 
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The settings from which you can pick include the following. 

• Who do you want to share the notebook with? Who do you want to have real-time group 
collaboration with? Decide if they are within your organization or specific people, which 
can be inside or outside the organization. If you choose Anyone with the link, all setting 
options are available. 

• Are you allowing them the ability to edit any page of your notebook? Check off the Allow 
editing box if you are ok with them editing pages in the notebook. 

• Do you want an expiration date for this share? With expiration dates, the share expires 
on a specific date. Upon expiration, the shared access to that person disappears from the 
notebook. 

• A password is needed to open the notebook. This feature could provide your notebook 
with another layer of security. 
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These settings are only visible for those using OneNote in an enterprise environment with a work 
or school account. 

 

Once you have share access to a notebook, you may change your mind and want to edit or 
remove that access. Let’s look at this next. 

 

Editing Or Removing Shared Access 
Changes are still possible after you share access to your notebook. For example, you can edit that 
access or remove that person from the share. The steps for editing or removing user access from 
the shared notebook are listed below. 

1. Click Share at the top right corner of the notebook and notice the shared access as 
depicted in the screen capture below. 

 

2. With your mouse, hover over any user icon in the Shared with area, and click the icon 
representing the user you wish to edit. 

3. The Manage access area opens up so that you can make changes to the share, see the 
following figure for an example of the Manage access dialogue box: 
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4. Click on the ellipsis to the right of the links and copy boxes. Each of these menus provides 
a separate prompt. For example, one prompts for setting an expiration date and another 
for editing access rights. 

5. Under the Manage access dialogue box links, you have access to the user for the share. 
As shown above, the username shows as Connie @ Mi… and has an x beside the 
username. If you click on this x, you will remove this user from sharing the notebook. If 
you do not see a username in this box, look for the user icon and click on the down arrow 
beside that user icon. 

Sharing Notebooks Via Teams 
OneNote notebooks are an integral part of Microsoft Teams. Sharing notebooks with team 
members is easy. By leveraging the integration, teams can create and share real-time notes, 
ideas, and meeting minutes, promoting seamless collaboration.  

 

The OneNote tab in Teams provides easy access to notebooks within any Teams Channel. Using 
OneNote notebooks within Microsoft Teams provides a powerful tool that helps your teams work 
more efficiently and effectively, improving productivity and teamwork. 
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You can add OneNote easily as an App to a Teams Channel. 

To Add the OneNote Application: 

1. Click on the Team and Channel where 
you want OneNote to reside. 

2. Click on the Plus Sign (+) at the Top of 
the Channel Posts area. 

 

3. Choose OneNote from the apps listed (search for OneNote if it does not show on your 
screen immediately). 

4. Choose the default notebook that is listed. Every Team created has a default notebook. 

Once you start using this notebook in your Teams environment, everyone in the Channel can 
add to the notebook. You are automatically sharing with the entire team. 

 

SharePoint and Notebooks 
OneNote notebooks are a standard part of a SharePoint site and are available to users by default. 
Notably, when you create a new SharePoint site, a corresponding OneNote notebook appears 
automatically. Therefore, team members can use OneNote to capture and share ideas without 
additional setup.  

 

The OneNote notebook is accessible from within the SharePoint site, and team members can 
work on the same notebook simultaneously, allowing for real-time collaboration. In addition, 
OneNote provides an organized and efficient way for team members to store and access 
information, ensuring everyone is up-to-date and on the same page. With OneNote notebooks 
as a standard part of a SharePoint site, teams can work more effectively and efficiently, ultimately 
improving productivity and results. 

Look in the navigation area for the Notebook. 
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Conclusion 
In conclusion, OneNote is a versatile tool that you can use for various tasks, from organizing notes 
and ideas to storing and retrieving important reference information. Throughout this 
presentation, we have explored various OneNote can help individuals and teams reduce email 
and collaborate more efficiently. In addition, we discussed the benefits of sharing a page or 
notebook with others and the features of OneNote that make it easy to organize and find 
information quickly. 

Some of the critical features of OneNote that we have covered include sections and pages, 
sending emails into OneNote, tagging and searching for tags, searching for information, and 
storing documents and links. Additionally, we have emphasized the importance of using OneNote 
on multiple devices, as it allows for seamless collaboration and access to information no matter 
where you are. 

Lastly, we have outlined the process for acquiring OneNote and highlighted that it is available on 
many devices. So whether you are an individual looking to organize your personal life, or part of 
a team looking to streamline collaboration and communication, OneNote has something to offer. 
With its user-friendly interface and powerful features, OneNote is an excellent tool for staying 
organized, productive, and connected. 

 

 


	Introduction
	Major Topics
	Learning Objectives
	What Is OneNote
	OneNote Is Available On Many Devices
	Two Desktop Versions Of OneNote

	Creating Your First Notebook
	Opening OneNote From A Different Device/Computer
	Opening OneNote From The Web Application

	Storing And Retrieving Information Easily
	Creating Notebooks, Sections, And Pages
	Creating A Page In The OneNote App
	Entering Information Into Your Pages
	Titles
	Typing Text


	More Notebooks
	Add Emails To OneNote
	Use Send to OneNote button in Outlook
	Documents
	File Printout
	File Attachment
	Document Link
	Do You Have Access To The Link When You Need It?


	Links
	Paragraph Links
	Copying Links From The Paragraph
	Link To Another Page In Your Notebook
	Link To All The Pages In A Section
	Link to A Page In Another Section
	Go Back To Previous Page
	Edit Your Link

	Referencing Your Notes With Tags
	Types Of Tags
	Search for Tags

	Searching Notes
	The Search Box Or CTRL-E
	Search Box At Top Or ALT-Q

	Recent Edits Or Recent Notes
	Extracting Information From Websites
	Copy And Paste From A Website

	Sharing Your Notes
	Sharing a page of your notebook
	Sharing A Notebook Link Via Email
	Editing Or Removing Shared Access

	Sharing Notebooks Via Teams
	SharePoint and Notebooks

	Conclusion

